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Chapter 1.04: Language

Options

Overview

Route Manager offers a flexible language option that is
simple to work with and includes a dozen different
language choices. In addition, every word or phrase
displayed on the screen can be modified to suit the
needs of each company. Even if you don't need a
"foreign" language, you may want to customize terms
that you use. Whether it's to add a real name to user-
defined fields or change every place you have the word
"truck" to "big boom boom", this is the place to do it.
This chapter will guide you through the process of
loading and customizing language options.

Getting Started

Prior to getting started, it is recommended that the
user editing the language file be someone that has
technical experience and has advanced working
knowledge of Route Manager — it is simple to change
text, but can create headaches if not done properly.

Essentially every word and phrase appearing in the
program can be modified or translated.

There are two methods available for editing language
options:
Language Maintenance: This option allows you to
load alternate languages, and view and edit the
language table. This is the primary way to perform
language changes.

Direct Edit: This option allows you to make on-the-fly
language changes by placing the mouse cursor over a
word or phrase displayed within the program, and
holding down CTRL+W.

Each language editing option is discussed in detail
within this document. You will usually want to use both
methods as you customize the language for your
software.
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Language Maintenance

Follow the steps below to load or customize a language
file. Each option is discussed separately.

Loading a Language File

By default, the language already displayed in your
Route Manager program was selected during the
installation of the program. If additional language files
need to be used in the system, they can be
downloaded from our support site. All languages
provided are located in your RMA>Languages folder.
Here is a sample of what's available.

Mame = |

| 3BritishEnglish
| Chinese
|[ZiDeutsch

| ZJEspanol

| ZIFrancais

| Ttaliano

| Z)PakistanEnglish
| Z)Propane

| I Russian
|ashredding
|Ivietnamese

Once you have downloaded or copied the language
folder of your choice, it will need to be placed within
the ‘Language’ folder of your RMA directory.

Windows (C:) » EMA » LANGUAGE »

rary v Share with = Mew folder

L -~
Mame

. english
. Espanol
| Francais
To load the new language file on the current

workstation, browse to File > Local Settings, and select
the Modify key in the Desktop tab.

Series 7.1.X
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Choose the new language file from the ‘Program
Language’ drop-down list and click Save.
Wi/ Local Settings =10l
Local Settings

Desktop ICommunl:atlons I Directories 1 Printers 1 Reports ‘ Colors I MyToo\barl
Cusiomer Miscallanzous
Defaulttab in Customer Info Screen | Info i Dontuse Autosense on Find I~
Customer Info/Credit default page | Status/Cont . =
Default Equipment Status Customer Info | ALL = Default Payment Type ,—L| X

srowse O [Hons =] Program Langusge |

Disable Browse in Customer Information [~ &
Check ScanngEuliEil
Top ltem in Find ot Espanol
Use leftto right search on lookups [~ Francais

Use Caller ID with Advanced TS Client [
Display Statements on Drill Down [

Number of Periods in Drilldown| g El:
Package Plan Contract Expiration Days 1] Eli
Do Not Preview Invoices [~ rivas
Order by Start Time in Route Pre-Sale [~ e
Prompt to ‘Edit Customer after completing wizard [ Gard Reader | C
Use delete method instead of format to clear card

PRIz

RMLive Refresh Rate (in seconds) 0

Show weight Option in RMLive I~

Once you exit from the Local Settings screen, the new
language will be updated.

Period MO_DEC 2014 | (@B [ E]

Repeat the steps above on each workstation that will
use the new language file. In addition, on the tool bar,
you will be able to identify the language by the blue
square showing the first 2 letters of the language. This
will show the language to be edited.

Series 7.1.X
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Customizing a Language File

Use this option to customize the current language file.
This can be helpful for updating text to fit closely with
your company’s terminology.

Navigate to Tools > Language Maintenance, and click

the ‘OK’ button on the warning screen.

7 Editing Language Tables

Language Tables

Base Languags. [ETTE NN -] | EdiLanguage

English

RM Enterprise

S5

WARMING! This is a live edit. If you make changes you can only unde
% the change in the current field (with CTRL+Z) and not the whole table

=

EXIT

The Language Table screen is split into two sections:
Base Language and Edit Language.

To create a custom language file, create a new Edit
Language by selecting the Add key on the right side of

the screen.

7 Editing Language Tables

Language Tables

Base Language ‘ English

j‘ Edit Language. |English

>

“First Class Mail”

“First Class Mail”

“IVA Tax Included”

“IVA Tax Included”

“This document not valid as an invoice™

“This document not valid as an invoice™

# Credils # Credits

# Credits # Credits

#Held #Held

# of days to evaluate for Activity/Inactivity # of days to evaluate for Activitylnactivity
# Ordered # Ordered

#H #H

#H #H

## % Complete (PRESS [ESC]TO

## % Complete (PRESS [ESC]TO

## % Complete  (PRESS [ESC] TO ABORT)

# % Complete  (PRESS [ESC] TO ABORT)

## % Complete (PRESS [ESC] TO ABORT)

## % Complete (PRESS [ESC] TO ABORT)

3

FIELD: chkchangeonfirstlogin.caption

EXIT
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Give your new language file a name, and select the
Base Language that will be applied to the new
language. Click OK to continue.

Mew Language|

Copy Frnm| j

v | X |

Your new language file will automatically be loaded on
the Language Tables screen.

Language Tables
Base Language. |Cust0m_eng|ish j| Edit Language. Custom_english j
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Scroll through the list of items, or use CTRL+F to search
for a specific term. Once you have selected an item
that you would like to update, click in the yellow text
field to modify the Edit Language — the Base Language
will always remain the same, for reference to the
original text.

Ml Editing Language Tables 2
Language Tables
Base Language ‘Cusmm_eng\ish j ‘ Edit Language. |Custom_english j st
EXIT
MAINTENANCE INFORMATION MAINTENANCE INFORMATION - —
Maintenance Personnel Maintenance Persannel
Maintenance Personnel Maintenance Personnel
Maintenance Personnel Maintenance Personnel
Major Major
Major Account Major Account
Major Account Major Account
Major Account Major Account
Major Account Major Account
Major Account Major Account
Major Account Code Major Account Code
Major Account Code Major Account Code
Major Account Code Major Account Code
Major Account Code Major Account Code
Major Account Code Primary Account
Major Account Code Wajor Account Code
Major Account Code Major Account Code il
RECORD: 17293 SCREEN: RMRSGLSTCUST FIELD: PagefFrame1.Page1.Label5.Caption

In this example, the term ‘Major Account Code’ is being
updated to display ‘Priority Account’ within the
Customer Information screen.

The screen that each change will apply to is displayed
on the bottom of the Language Tables screen:

NOTE: For a definition of each screen in RMA, refer
to the Technical Reference Guide available at
www.ARS247.com.

Repeat these steps for each item that you would like to
update, and exit the Language Maintenance screen.

Series 7.1.X 6
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To load the new language file on the current
workstation, browse to File > Local Settings, and select

the Modify key.

Choose the new language file from the ‘Program
Language’ drop-down list, and click Save.

b Local Settings S
Local Settings
Desigop |Cnmﬂ|un|csuoﬂs | Direcaories | Printers | Repons I Cosors My Tooibar
usimar dlizslinnesus |
Detaust ta in Custimet Into Serean [Info x Donluse Aubesense on Find T

Custamur NfGroas detaun page | SatsCont x|
Dol Equipment Stazs Customer inf | ALL | Detaum Payment Trod .] > 1

Brows Crder [Fene -] Program Langusge = || T |

matien [ |
Disacte Browse in Customer infermation w"" Castam_sogiah anni]
Too e in Find | | |Engiisn

Use e o right search o lnokups [
Lo Calles 1D with Advanced TS Chient [
Disphay Statements on Drill Deown [

Humber of Periods in Drilidown| g =]
Package Plan Contract ExpiraSion Days 0 5
Do Nat Pravew invaices [
Crder by St Time in Route Pro-Sale >
i CardReaver[C

Prampt 1o BOF Cuslomar 38er complaang wizard [
Uss celete mamod inslesd of format o cheas card [

TidLive
RMLIe Refrash Rata (in seconas) | [}
Sheow Wielght Option in RMLive I

Once you exit from the Local Settings screen, any
custom language information will be displayed.

—— e - |
/7 Customer Information - 060002 =~
Customer Information T —
08002 MAYANRESORT J PAST UL 4995
[in2]| 5 | invoices | crean | Paymentinto | Contacts | Route | Route info | Procucts | Equipment | Stap History | Orders | .
Acct Mo ["E“Dﬂ') Customer Type | . j Resdentad Account Hame Branch | -- -] TURLOCK BOTTLED Wa !-
&ill Ty Grantird i
Hame Phone = Fan i -
| wayan RESORT | 20245861111 | -- —
2P o y Work Phan B Ed gl = 2l
+|[esaes ] I | Detail | #] [~- |-~ +
Agdress Contac Contact Pheng =2 ™
| 9521 MORTON DaWS DRIVE (T |202-458-1111 ——)
I Billing E-Mail Addressis =] [
[paTTER=ON cA " -2
l;m &
lﬁ.ve.@.u.-.l:'zsr_ 2
EXIT
[T Sales Rep 1 [BU =] Entereany| S
| repz| =] sasrepa| =l
I __|
=3)
i ars best
=] Disansy oStareFront Login ™

Repeat the steps above on each workstation that will
use the new custom language file.

NOTE: If a mistake is made on any of your custom
language files, you can always correct the problem
by referring back to the Base Language description
displayed within the Language Maintenance screen.
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La
LNADVANTAGE

A A2 ROUTE S YSTEMS
www. AdvantageRoutecom

Language Display on the Module Bar

The first two letters of the language being used at each
workstation is displayed on the system Module Bar:

Period MO_DEC 2014 | (@B [ E]

Double-click on the language option to edit the
language setting within Local Settings.

NOTE: When creating new language files, try to use
a naming convention that defines the file based on
the first two characters (i.e., BE for British English).
This is helpful for reference on the Module Bar.

Modifying Language by using CTRL-W

You can manually update language on most of the
program screens by placing the mouse cursor over the
displayed text and pressing CTRL+W.

In the example below, the ‘Text 2’ field is to be changed
to ‘Reference Number’ under the Credit tab within
Customer Information.

1. Place the mouse pointer over the field to be modified.

B Cuttemnes Infermation - 030007 = |

Customer Information I —
a0onz

i | & | imveice |

Shatys/ B |

¥

3 |

— |

a3 [
! )
LN

=1

Series 7.1.X 8
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2. Enter CTRL+W on your keyboard.

W Customer Infamation - 080002 =2l

Customer Information T
080002 MAYAMN RESORT

0
0]
U‘

PAST OUE 40,95

\nrol sl Invaices  Credit |Papmcman|n| Contacts l Routs | anmml Pragucts [ qupmnnﬂl Smﬂl»islnrrl Ordars | [
statysConbact | CreditTerms | Bngstatement | cuc semngs ] ) 7 RemerdPoints | =
magi[F omer [T 4 %
ozl oaez[7y F| —_—
mega[ Gt 3 ,rj_ 4 o
Text 1 . Check 1 Jl: 18
Test 2 | — —————. tegeal _w |
) N u |
Humber 1 ) 000 Tz _"_
Humibar 2 | .00 - 3 &5
Humber 3 0 000 rﬂ |L| _‘K_
EXIT
3. Enter the new description that you would like to
display, and click the Save key.
¢ Customer Infeemation - 080002 a3
Customer Information T —

080002 MAYAN RE SORT PAST DUF 49,8

Wlo | 5| voiors  Crae |F‘sr|n=nllnﬂo| Goetacts | Route | Route i | Products | Equipment | Stop Histery | rders |

suusconaa | CreanTems | | cucsenngs ] 7 Remaapoins |

Flag!,: Date [ 17 4
Fag2| Date 2 ,l.'—él
Fisad oate3[ 1 El

Ted 1 Chack 1™

Text 2 ——— e

b Reterence Numser
Husmzer 1 0.000] e
Humeer 2 ‘a000|— — -
Humaer 3 T B | X |

Bl o) o
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The new description will now be displayed.

¢ Customer Information - 080002 =] = ==
i |____Hotoservice |
Customer Information ——
080002 MAYAN RESORT | PAST DUE 49.95
\nfu} I Invoices ~ Credit }Pa-fmemmfu \ Cmnans} Route I Ruummm} Products I Equlpmentl Stop H.smﬂ Orders I #
Stalus/Contract ‘ Credit Terms ‘ Billing/Statement | CHC Settings ‘ " RewardPoints 2=
Flag1|P Date 1| 1/ é‘ -
Flag2 pate2[ 7 ﬂ 7
Flag3 pate3[ 7y ﬁ 1
Teut 1 ‘ Check 1~ — 1
Check2 [~
Reference Number Check3l™
Text 3 ‘ Check4 [~
Check5 [ I
Number 1 il
Number 2 =1
Number 3
EXIT

This option will edit the language file that is currently
loaded on the machine. Be sure you have the desired
language. If you do it to "English", the next time you
upgrade your software, you will lose and edits you have
made.

NOTE: To restrict users from changing language
using CTRL+W, you can restrict access to the
‘Language Maintenance’ option within Lists >
Employee Setup > Security Level Codes.

Series 7.1.X 10



La
LNADVANTAGE

A A2 ROUTE S YSTEMS
www. AdvantageRoutecom

Tips and Pointers

This section provides you with tips and pointers that
may be helpful when using the Language Maintenance

screen.
7 Editing Language Tables £
Language Tables
Base Language. |Eng|ish j | Edit Language English j EE"
EXIT
-
“First Class Mail “First Class Mail*
“IVA Tax Included” “IVA Tax Included™
“This document not valid as an invoice” “This document not valid as an invoice”
# Credits # Credits
# Credits # Credils
#Held #Held
# of days to evaluate for Activity/Inactivity # of days to evaluate for Activity/Inactivity
# Ordered # Ordered
#H ##
H #H
## % Complete (PRESS[ESC]TO ## % Complete (PRESS [ESC]TO
## % Complete (PRESS [ESC] TO ABORT) ## % Complele (PRESS [ESC] TO ABORT)
## % Complete  (PRESS [ESC] TO ABORT) ## % Complete (PRESS [ESC] TO ABORT)
8 3 i
SCREEN: RMRSGLSTLOGINPOLICY  FIELD: chkchangeonfirstlogin.caption

B The Base Language is the original language table
currently being used. After an update or upgrade, the
Base Language may contain new fields.

# The Edit Language can always be modified.

p If you would like to sort the list by the Edit Language,
simply click on the Edit Language button and the sort
order will be updated. Use the same method for
sorting by the Base Language.

B The file information displayed on the bottom of the
screen indicates the area of the program that will be
affected by the language change. Red indicates that
the item is displayed within a report; Blue indicates a
display screen.

B CTRL+F can be used to search through the language
file.

B Grant only administrators the ability to edit language
by disabling access to the Language Maintenance
option within each Security Level Code.

Series 7.1.X 11
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Copyright © 1994-2016 by Advantage Route Systems,
Inc. All Rights Reserved.

Printed in the United States of America.

Advantage Route Systems, Inc.
3201 Liberty Square Parkway
Turlock, CA 95380 USA

Phone: 1.209.632.1122

Web Site: www.AdvantageRS.com

Email: info@AdvantageRS.com

Warning

All information in this document and the on-line help
system, as well as the software to which it pertains, is
proprietary material of Advantage Route Systems, Inc.
and is subject to a Route Manager license and non-
disclosure agreement. Neither the software nor the
documentation may be reproduced in any manner
without the prior written permission of Advantage
Route Systemes, Inc.

Series 7: Version Date, January 8, 2016
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